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Introduction
With the introduction of Windows 8 Microsoft relies on the tiles concept for structured visualization of programs,
apps and information on the home screen. Even SAP has taken up this idea,  and with SAP Fiori, they have created
a simple user interface that is build on this tile concept - adapted to the needs of operational business applications.

It was therefore obvious for us to develop a tile solution for Business Intelligence (BI) – the more so as our
customers have signalled a demand. They wanted a start screen for dashboards that clearly represents the key
performance indicators (KPIs).

From this highly aggregated view the user should jump – in terms of a pre-defined navigation path – on graphical
overviews or detailed table views created with our  and  – see Figure below –graphomate charts graphomate tables
from starting point to detail

After a first gathering of the customer requirements pertaining to a tile solution it was obvious that there is no single
tile that can be used for all purposes: too different were the demands on the visual requirements. The solution had to
be a modular construction kit, which allows users to combine different tile modules on a pre-defined layout.

The question remained how to create a uniform design of these modules and the whole tile. Here we were able to
draw on the great work of John Armitage: his design proposals for analytical tiles were our aesthetic standard for a
consistent style. His book “Bringing Numbers to Life: Lava and Design-Led Innovation in Visual Analytics” should be
published in Q1 2016.

For our  extension Design Studio 1.6 SP00 or higher or Lumira Designer >= 2.0 and IE 11+ aregraphomate tiles
required. For further information, for example about the deployment on the Business Intelligence Platform (BIP) or
SAP Netweaver, please consult the Product Availability Matrix (PAM). Please note that from 2017, we will no longer
support Internet Explorer 9 and 10.

In the sense of a uniform language regulation we speak in the further manual of Lumira Designer or briefly
designer. Our products are still compatible with SAP Design Studio 1.6.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Installation

Local installation of the extension to Designer

You have installed Designer 2.0 SP00+ on your computer.

Save the zipfile  to a folder of your choice.graphomate_tiles2.0.x.zip
In Designer, choose  click on  and select the zipfileTools  Install Extension to Lumira Designer, Archive
which has been saved before.
Choose  to start the installation.Finish
Choose  and again  to confirm the installation.Next Next
Accept the terms of the license agreement and choose .Finish
Choose  to allow a restart of Designer.Yes
After the restart, the graphomate extension appears in the Component View of Designer.

Removing the extension from Designer

In Designer choose ….Help > About

Click the  button.Installation Details
Select the component graphomate tiles 2.0.x
Choose … .Uninstall
In the UninstallWizard choose .Finish
Choose  to allow Designer to restart.Yes

Before opening your old dashboards/BI apps with Designer 2.0, you need to migrate them to m
mode with Design Studio 1.6.
Our extensions for Design Studio 1.6 will also run in Designer 2.0. When starting Lumira 2.0
Designer, please do not import our graphomate extension from SAP Design Studio 1.6. Instead
we suggest using the versions specifically built for Designer 2.0.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Server installation of the extension

Users need to deploy the locally installed extension to the BI platform before launching the fromgraphomate tiles 
the BI platform.

Choose in the BI Platform Mode Tools > Platform Extensions.
Select the extension  that is installed on your local computer.graphomate tiles
Choose Install on Platform.
Manually restart the BI Platform Adaptive Processing Servers that host the Analysis Application Service
and accept the warnings in Designer.
The graphomate extension appears under Extensions Installed on Platform.
Choose .Close
Again restart the BI Platform Adaptive Processing Servers that host the Analysis Application manually.

Uninstalling the extension from the Server

Choose in the BI Platform Mode Tools > Platform Extensions.
Choose the .graphomate tiles
Choose Uninstall from Platform.
Confirm the uninstalling by choosing .Yes
In order to complete the uninstalling process, manually restart the BI Platform Adaptive
Processing Servers that host the Analysis Application Service and accept the warnings in Designer.
The  tiles is then removed from the graphomate Extensions Installed on Platform.
Choose .Close
Manually restart the BI Platform Adaptive Processing Servers that host the Analysis Application Service.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Quick Start

You have defined a Data Source and now want to depict Data Series from this query with modules of the graphomat
.e tiles

Drag the component  to the canvas and bind the Data Source to this component viagraphomate tiles
drag&drop. Unfortunately, it is only possible to assign one Data Source per tile (as for all Designer
components).

Now you can configure your tile on the  tab: To do this, first select a layout and afterwardsGeneral/Layout
choose the desired modules and drag and drop them to the Builder. The properties for each module are then
generated in the background. You can adjust the properties on the next tab Modules.

There you can select via Display Dimensions which dimensions and measures from the data source should
be displayed in the modules. This option is strongly related to the chosen module (some modules do not
require the visual display of dimensions).

Via the  tab you determine the comprehensive number format for the tile.Appearance

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Properties

Basically, you have two ways in which to change the properties of :  graphomate tiles
Using the  , that shows all the parameters in a structured list or via the Standard Properties Sheet Additional

. The latter offers a more user-friendly Interface. Properties Sheet

The check boxes   in front of properties in the   are used to control the visibility ofAdditional Properties Sheet
elements and activation of functions. The data source to be used can only be assigned via Drag&Drop to the
component or to the   under  .Standard Properties Sheet Data Binding

By pressing the F5 key, both the range of characters as well as the Additional Properties Sheet can be
reinitialized. This is sometimes necessary when changes in the properties are not adopted directly in the
character range.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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General/Layout Tab
Modules

Here you can see a list of all currently available modules that can be used to design your tiles. The range of
modules is constantly growing with new releases of the graphomate tiles. A detailed guidance on each module and
its options can be found in the description of the Modules tab.

The Lines Module visualizes trends and thresholds with
two lines.

The Bullet Graphs Module shows up to five bullet
graphs after Stephen Few's concept.

With the Pies Module you can visualize percentages
and a deviation in a pie chart.

The Sparklines Module displays up to ten small,
individually scaled line charts.

The Title Module allows a data-driven definition of two
title lines and an icon.

The Column Module shows up to three columns with
data labels.    

The Footer shows a measure with labels in one line.

The KPI Module visualizes a measure as large
number.

The Legend Module shows up to three items for a
color-based legend.

The Bars Module shows zeigt analogoug to the
Columns Module up to three bars with data labels.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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The Stacked Column Module shows a data series as a
stacked chart.

The Table Module displays texts and figures in form of
a list.

The Waffles Module displays up to two data series as a
segmented bar chart.

The Icon Module displays a single icon.

The Text Module displays up to three lines of fully
HTML capable text.

This switch can be used to select the face of the tile
to be configured.

Each face has its own configuration. This extends
to modules, databinding, layout as well as layout
options. However, only a single data source is
permitted per tile.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Builder

Via mouse click you can choose from currently 24
different layouts that consist of up to three lines and
two columns. To set a certain layout just click on
the little grey icon; it then turns blue and the
available layout slots are displayed beneath.

Then simply drag one of the modules above to the
desired row or column of the Builder and drop it
there.

According to the selected module, data connection
and available options are generated in the
background and displayed on the Modules tab.

Please bear in mind that Design Studio allows only
one data source per tile.

Already selected modules can be moved within the 
 via drag and drop. Assigned dataLayout Builder

and other settings are retained.

Modules can be deleted using the button with the
little x in the top right corner of the module icons.

Layout Display Options

Depending on the chosen layout different options
are available here.

For example, the height ratio of the rows to each
other can be adjusted. (A selection of 1:1:1 results
in identical heights of the three rows).)

For layouts that contain more than one column,
there is also the option to adjust the width ratio of
the columns to each other. (A selcection of 1:1
results in identical widths of the two columns.)

The option  activates thinShow Divider Lines
dividing lines between the rows of the layout.

Adjust the thickness of these dividing lines via Divid
.er Thickness

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Padding allows you to set a uniform distance that
affects each individual module (green highlight in
the figure on the right shows the default setting of 5
pixels). The Padding at this point has no effect on
the dividing lines; for this use the Component
Padding on the Appearance tab (blue highlight).

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Modules Tab

On this tab, data from the chosen data source can
be assigned to the selected modules. The contents
of this tab is generated from the modules chosen
on the  tab.Layout

Due to the dynamic nature of the tiles, the available
script commands to control the behavior of the
modules are generated only after the module
selection.

The script commands can be found by clicking on
the icon. A popup will appear from which the
available commands can be marked and copied
with the mouse. Clicking in the Additional Property
Sheet outside the popup will let it vanish.

With a click on  , you can select data from the
data source to be used with the module. A click on 

 will delete the selection.

To easily identify the assigned data property, its
name is displayed in brackets after the dimensions
of the current selection (e. g. dataSingleCell2).

By clicking on , you can choose the Display
Dimensions from the metadata to be used in the
module.

In certain modules (e. g. Title Module, Footer
Module), these can be addressed via a set of
wildcards. The following wildcards are available:

[DIMENSIONS] – shows all dimensions

[DIMENSIONn] – shows the n-th dimension (up to
DIMENSION6)

[SCALE] – shows the scaling factor

[UNIT] – shows the unit

[VALUE] – shows the value of a single data cell

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Bar Module

Use the  to display up to three differentBar Module
measures including category labels and values.
The categories displayed correspond to the
selected Display Dimensions.

Max. Bar Height and  govern theMax. Label Height
behavior of the module when the tile is resized;
bars and labels will scale up to the determined
heights in pixels

If the option  is activated, theAbsolute Label Height
labels do not scale with the size of the tiles; instead
the entry in Max. Label Height is used as the font
size.

Scaling Helper will display a help line at the
specifiied Scaling Helper Value.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Bullet Graph Module

The  corresponds to ourBullet Graph Module
graphomate bullet graphs extension. It is based on
Stephen Few’s conceptual considerations regarding
the display of KPIs.

A detailed description of all parameters would go
beyond the scope of this chapter. We’d like to refer
you to the full documentation of the graphomate
bullet graphs here: de/en.

The following options specifically apply to the
graphomate tiles:

The option  determines the firstStart Element
element in the assigned data series to be
displayed.

The dropdown box  governsNumber of Elements
the number of bullet graphs to be displayed.

With the checkbox , theDisplay Category Labels
headers can either be shown or hidden.

Suppress Sums excludes all sums from the
selected data series.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Column Module

Use the  to display up to threeColumn Module
different measures including category labels and
values. The categories displayed correspond to the
selected Display Dimensions.

Max. Column Height and  governMax. Label Height
the behavior of the module when the tile is resized;
bars and labels will scale up to the determined
heights in pixels

If the option  is activated, theAbsolute Label Height
labels do not scale with the size of the tiles; instead
the entry in Max. Label Height is used as the font
size.

Checking will display a help line at Scaling Helper 
the specifiied .Scaling Helper Value

https://graphomate.atlassian.net/wiki/x/H4CCAw


graphomate tiles

16 / 37

Footer KPI Module

This module is used to display a single KPI
(Measure) together with its metadata

If an accompanying  isComparative Measure
chosen, the deviation between these two can be
displayed, either as absolute value or percentage.
This can be set with the  option.Value Display

You can also use the manual input of values (Manu
 and );al Measure Manual Comparative Measure

these fields override the values from the data
assignment.

The input in  is shown in front of theText Input
measure. The metadata from the data source can
be inserted in the text fields with wildcards (see
page 10); by default all dimensions are displayed in
this module.

The checkbox  governs whetherIncrease is Good
positive deviations will be displayed in red or green.

Show Units, and  will display orShow Scaling Factor
hide unit or scaling factor from the data source.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Free Text Module

The Free Text Module shows up to three lines of
plain text. Wildcards can be used to extract and
display metadata. All three text lines support HTML
formatting.

The input boxes  take one line of textText Line x
each.

Fontsizes per row can be adjusted with the
properties .Fontsize Line x

For bold formatting, the checkbox  needsBold Titles
to be activated.

If the checkbox  is activated, textsWrap Texts
exceeding the space limit will be wrapped, resulting
in several lines of texts. Otherwise, they will be
abbreviated with "...".

The dropdown boxes  and Vertical Position Horizont
 influence the positioning of the text linesal Position

within the module.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Icon Module

The Icon Module can be used to depict a single
icon. This can be chosen from 19 predefined SVG
symbols or the full set of SAP UI5 icons.

Use the dropdown box  to choose the desiredIcon
icon.

Icon Color governs whether one of the
component-wide colors a an individually
configurable color is used. If "Neutral Color" is
chosen, the "Text Color 2" will be used.

The field  allows to insert an icon ofSAPUI5 Icon Id
the  library, for example, e00a for aSAPUI5
synchronize button. To display the icon, select SAP

 under  and write the Icon ID into theUI5 Icon Icon
appropriate field.

Max. Size is the maximal size of the icon in px. If
the slot is too small, the icon is reduced in size
proportionally.

The dropdown boxes  and Vertical Position Horizont
 influence the positioning of the text linesal Position

within the module.

In the icon explorer, the SAPUI5 icon ID
could be shown with a prefix for
hexadecimal encoding. The id needs to be
entered without the prefix; please use e. g.
"e00a" instead of "&#xe00a".

https://graphomate.atlassian.net/wiki/x/H4CCAw
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KPI Point Module

The  displays a single measure.KPI Point Module
The size of the number is scaled according to the
available space.

The options correspond largely with those of the Fo
 (see above); in addition, a oter KPI Module Max

 can be set. The size of the displayedFont Size
number will not exceed the determined font size.

The option  allows to placeMetadata Below Value
the additional information below the value itself.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Legend Module

The  can be used to display up toLegend Module
three keys together with the assigned colors.

The keys ( ) can be either enteredEntry 1 to 3
manually, or can be generated using the existing
wildcards (see p. 10). If wildcards are used, it is
necessary to assign data first, so metadata are
available.

To hide a key, simply empty the input field.

The colors to be displayed can be defined either
with the dropdown boxes  (TheColor Key 1 to 3
colors themselves can be changed on the
Appearance tab.). Alternatively you can choose
own colors with the fields  (forCustom Color 1 to 3
these colors, choose  in the fields Custom Color Col

).or Key

The checkbox  will format the keys in …Bold Text
well, bold.

The position of the colored squares can be
determined with the option  If  iColored Boxes. None
s selected, no squares are displayed, but the keys
themselves are colored accordingly.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Line Chart Module

https://graphomate.atlassian.net/wiki/x/H4CCAw
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The  allows the display of twoLine Chart Module
data series as lines and an additional  Fixed Value,
which can be used as threshold value.

The dropdown box  governs whichThreshold
measure(s) will be used as threshold value. If a
threshold is chosen, the difference area between Pr

 and threshold will be displayedimary Measure
colored. Depending on the selection, either the
differential area between  and Primary Measure Sec

 or  and ondary Measure Primary Measure Fixed
 is colored.Value

The thickness of all displayed lines can be changed
with the option Line Size.

If the option  is activated,Threshold Excess is Good
and a  is chosen, the positve differenceThreshold
area is displayed in green, otherwise in red.

The option turnsDisplay Primary Measure as Area 
the chart into an area chart.

If activated,  displays the firstShow Value Labels
and last value of the assigned  atPrimary Measure
the start and end of the line chart.

Show Category Labels displays the selected
dimensions below the axis; this options works
analogous to Show Value Labels.

Show y-Axis displays a value axis on the left side of
the line chart.

During runtime,  displays smallShow Click Handlers
circles around possible jump points, when the
mouse pointer hovers somewhere over the module.

Suppress Sums excludes all sums from the
selected data series. As only one data source per
tile is possible, this option can be useful if the sums
are needed in another module, e. g. the KPI
Module.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Pie Module

The  displays a percentage including aPie Module
deviation.

The value for the circle is assigned with the Circle
 option,  is used to assign the theData Arc Data

comparative measure, which is displayed as
circular segment.  shows a value asDeviation Data
deviation from the .Arc Data

The options  and Display Category Labels Display
 can be used to enhance the graph withValues

metadata from the data source ( )Category Labels
and exact values.

With the checkbox  thePos. Deviation is Good,
interpretation of the deviation can be changed; this
way, negative deviations can be displayed as
positive.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Sparklines Module

The  largely corresponds to our Sparklines Module g
 component. It visualizes upraphomate sparklines

to ten data series as "word-sized graphics". As per
default, the  uses the full resultSparklines Module

set as data input; however, with the  button, a
smaller selection can be made. Minimum and
maximum in each sparkline are depicted as
red/green dots. Each individual sparkline is scaled
to its own minimum and maximum; the two grey
bars in the background of the sparklines give
orientation aid where the depicted data is located in
the overall data set. In the example above, the data
for Arkansas ist located in the upper third of the
result set, whereas Alabama and Alaska are
located near the bottom.

Number of Elements This options governs the
number of lines of data that are used to generate
sparklines.

The entry in governs the first elementStart Element 
in the input data to be displayed. If e. g. a 5 is
entered, the first sparkline is generated from the
fifth line of data, lines 1 to 4 are left out.

With the option , categoryDisplay Category Labels
labels in front of the sparklines can be toggled on or
off.

Suppress sums excludes sums from the data to be
displayed.

Data in Rows governs whether the input result set
is interpreted in rows or columns.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Stacked Column Module

Use the  to display a dataStacked Column Module
series as a stacked chart. The categories displayed
correspond to the selected Display Dimensions.

Column Width, Max. Label Height and Absolute
 work analogous to the  or Label Height Columns Bar

Module.

If the option  is activated, the stackGraded Colors
elements are no longer colored monochrome with
white dividing lines, but as color gradations of Data

 (defined on the ).Color 1 Appearance Tab

If  is activated, and the connectedNegative Stacks
data series contains negative values, these are
sorted to be at the bottom of the stacked bar. In
addition, a small indicator is displayed at the
baseline.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Table Module

The  can be used to display severalTable Module
measures in a tabular form, either as absolute
values or percentage.

Color Display governs the text color of the table.

The option  can be used to determineStart Element
the first element in the data series to be displayed.
If e. g. a 5 is entered, the table starts with the 5th
element in the data series; elements 1 to 4 are
skipped.

Number of Elements narrows the displayed
elements to the number entered.

With  the maximal font size isMax. Font Size,
determined; up to this value (in pixels), the text will
scale with the tile.

If the options  or  arShow Units Show Scaling Factor
e active, the table will show these preceding the
first value, provided they are contained in the data
source.

For ease of reading, the option Alternating
 can be used to toggle light-greyBackground  Color

bars in the background of every other line.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Title Module

The  is text component with either oneTitle Module
or two rows, and an optional icon.

As described above, the metadata from the data
source can be inserted in the text fields with
wildcards; alternatively, the texts can be entered
manually.

For bold formatting, the checkbox  needsBold Titles
to be activated.

If the option  is activated,Absolute Label Height
both lines of text use the global fontsizes
(Appearance Tab). If the option is deactivated, the
text size is scaled down if necessary.

The Icons to be displayed in the right of the module,
as well as their color, can be set either manually or
via scripting. To choose manually, select the
desired icon from the dropdown box. The size of
the displayed icons scales with the font sizes of title
and subtitle. These can be set in the Appearance

.tab

The field  allows to insert an icon ofSAPUI5 Icon Id
the  library, for example, e00a for aSAPUI5
synchronize button. To display the icon, select SAP

 under  and copy the Icon ID into theUI5 Icon Icon
appropriate field.

If is deactivated, theAbsolute Label Height 
option  is ignored; also, inlineWrap Title
HTML tags will not be interpreted.

In the icon explorer, the SAPUI5 icon ID
could be shown with a prefix for
hexadecimal encoding. The id needs to be
entered without the prefix; please use e. g.
"e00a" instead of "&#xe00a".

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Waffle Module

https://graphomate.atlassian.net/wiki/x/H4CCAw
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The depicts up to two data series asWaffle Module 
segmented stacked bars ("waffles").

The option toggles the display of theDisplay Values 
underlying values.

With , category labels canDisplay Category Labels
be toggled on or off.

Number of Elements This options governs the
number of lines of data that are used to generate
waffle bars.

The entry in governs the first elementStart Element 
in the input data to be displayed. If e. g. a 5 is
entered, the first bar is generated from the fifth line
of data, lines 1 to 4 are left out.

Suppress sums excludes sums from the data to be
displayed.

The option governs whether theAxis Alignment 
bars are aligned with the left component border
("Leftbound"). If "Center" is chosen, the 0-axis is
located in the center; in this case, the bars will be
drawn from the center to the left and to the right.

With the option the interpretationCalculation Base, 
of the input data as either absolute or percentual is
determined.

The value  is only used if "Absolute" isUnits per Box
chosen as . It is used asCalculation Base
calculation basis for a single box in the waffle
pattern. If e. g. a value of 4500 is to be depicted,
and 100 is specified as the bar willUnits per Box, 
contain 45 little squares; an input of 1000 results in
4.5 squares.

The value in  is applied ifPercent per Box
"Percentage" is chosen as . In thisCalculation Base
case, the sum of both data series for each pair of
bars is interpreted as 100%; an input of 1 results in
100 boxes for both series, an input of 5 results in 20
boxes for both series.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Appearance Tab

Font Sizes

In this section, the  used throughout thefont sizes
tiles component can be adjusted. All inputs are in
pixels. Likewise, the  can be changedfont family
here.

Padding

The padding defined here affects the space
between the border of the overall component and
the modules contained within (blue frame in the
picture on the right). Thus, it also effects the divider
lines between the modules. Individual module
paddings can be adjusted on the  taGeneral/Layout
b.

Border Size

This property governs the border size of the
component. If a border size of 0 is specified, no
border will be displayed.

Grid

The option  activates a grid function; ifSnap to Grid
checked, the size of the drawing area can only be
changed in the intervals determined in the Grid Size
input field.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Color Configuration

The general color configuration is defined in this
section. In this way, the consistent appearance of
all modules in a given tile is ascertained. Adjustable
are the colors for good and bad values, two text
colors and two data colors as well as the color of
the component border which also affects the slot
divider lines.

Value Format

In this section, the format of all value labels is
determined:

Basic
Here, you can change the presets for absolute
and percentage value according to numeral.js.

 changes the country setting. If set to Locale AU
 the country setting will be governed by theTO,

data source.

Extended
If a fixed format is desired for the value labels,
this can be done with the extended number
format. The resulting format string can be set
via scripting as well. See Number Formatting

https://graphomate.atlassian.net/wiki/x/H4CCAw
https://graphomate.atlassian.net/wiki/spaces/GTE/pages/77734472/Number+Formatting
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Behavior Tab

Scaling

In this section, the scaling mode can be changed. If
set to Auto, each module will be scaled according
to the minima and maxima of the selected module;
scaling will usually start at 0. The setting Manual
enables you to enter particular minimum and
maximum values.

If the scaling is set to Auto, the tile can be
registered in a Comparison Group by activating the
checkbox. If active, the Comparison Group will
govern scaling; all components within this
comparison group will be scaled identically and an
indicator of the comparison group is shown during
design time.

Within the BIApp, comparison groups are used
globally, i. e. graphomate tables, graphomate
charts and graphomate bulletgraphs which are part
of the same comparison group will be scaled
identically.

Note: pie modules are scaled according to their
surface and are not compatible to other modules
and or components within the same Comparison
Group. Therefore It is advisable to use a separate
Comparison Group for tiles containing pie modules.

 

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Flip

In this section, the flip effect of the tile can be
configured.

The dropdown box governs whether theFlip Effect 
tile can be flipped or not.

The control element beneath can be used to select
the desired flip action.

Flip Duration governs the animation duration in
milliseconds. If e. g. a 1000 is entered, the
animation will last for one second.

If the flip effect should only be triggered on a
specific module, this can be realized with a small
script in the  event:On Component Selected

if (GRAPHOMATETILE_1.getSelectedModule
() ==
1){GRAPHOMATETILE_1.toggleFlip();}

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Info Tab

This section contains information about the installed
version of  as well as a link to agraphomate tiles
feedback form on our website.

The Credits contains an overview of the used
libraries.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Number Formatting
Possible Input for The numeral.js Format String

Floating point

Number Format String Output

10000 '0,0.0000' 10.000,0000

10000.23 '0,0' 10

-10000 '0,0.0' -10.000,0

-0.23 '.00' -,23

-0.23 '(.00)' (,23)

0.23 '0.00000' 0,23000

0.23 '0.0[0000]' 0,23

1230974 '0.0a' 1,2m

1460 '0 a' 1 k

1 '0o' 1st

Currency

Number Format String Output

1.000.234 '$0,0.00' $1.000,23

1000.2 0,0[.]00 $' 1.000,20 $

1001 '$ 0,0[.]00' $ 1.001

Percentage

Number Format String Output

1 '0%' 100%

-0.43 '0 %' -43%

Source 

https://graphomate.atlassian.net/wiki/x/H4CCAw
http://numeraljs.com/


graphomate tiles

36 / 37

Possible Input for The Extended Number Format String

Percentages and absolute numbers are formatted separately. For this two format strings are used, which follow
the same rules and structure. In general the strings of characters in the format string are simply replaced in the
input number. Exceptions to this rule would be scaling factors and the number of decimal places. 

The elements of the format string are separated by the "|" character. Format strings with less than 7 elements (or
6 "|" characters) are considered invalid and therefore ignored. In this case the standard format without scaling
and with one position after the decimal point is used.

The format string consists of the following elements, the ordering is obligatory and cannot be changed:
| | | | | |Negative Prefix Thousands Decimal Scaling PointsAfterDecimal Suffix

Negative The prefix for negative numbers. The string "()" will result in the number placed inside
parentheses, including eventual prefixes and suffixes. If   is used, the absoluteNone
number will be shown.

Prefix A prefixed string of characters, for example a currency symbol or an identifier for the
scaling factor.

Thousands A separator for thousands.

Decimal A separator for the decimal places.

Scaling The scaling factor for the value. This can be given as a whole number or a power,
formatted as   A whole number will be calculated as a power to the basis 10n^m.
internally. In case of a given power the value will be divided by it directly. Even negative
numbers are possible, for example "-3" or "10^-3"; in this case the value will get
adequately higher. Non numeric inputs are ignored.   given a "0" or a "1" willPlease note:
result in a scaling factor of 1. The only way to achieve a scaling by 10 is to set the input
to "10^1".

PointsAfterDecimal The number of places after the decimal.

Suffix A suffix for the value, analogous to the prefix.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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CSS Selectors

Overview of css classes

The following illustrations provides some of the css selectors, which can be adressed by using the   inCostum CSS
SAP Lumira Designer.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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